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Using This Online Manual

Symbols Used in This Document
Touch-enabled Device Users (Windows)

Symbols Used in This Document

Warning
Instructions that, if ignored, could result in death or serious personal injury caused by incorrect
operation of the equipment. These must be observed for safe operation.

Caution
Instructions that, if ignored, could result in personal injury or material damage caused by incorrect
operation of the equipment. These must be observed for safe operation.

Important
Instructions including important information. To avoid damage and injury or improper use of the
product, be sure to read these indications.

Note
Instructions including notes for operation and additional explanations.

Basics

Instructions explaining basic operations of your product.

Note
• Icons may vary depending on your product.

Touch-enabled Device Users (Windows)
For touch actions, you need to replace "right-click" in this document with the action set on the operating
system. For example, if the action is set to "press and hold" on your operating system, replace "right-click"
with "press and hold."
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Trademarks and Licenses

• Microsoft is a registered trademark of Microsoft Corporation.
• Windows is a trademark or registered trademark of Microsoft Corporation in the U.S. and/or other

countries.
• Windows Vista is a trademark or registered trademark of Microsoft Corporation in the U.S. and/or other

countries.
• Internet Explorer is a trademark or registered trademark of Microsoft Corporation in the U.S. and/or

other countries.
• Mac, Mac OS, AirPort, Safari, Bonjour, iPad, iPhone and iPod touch are trademarks of Apple Inc.,

registered in the U.S. and other countries. App Store, AirPrint and the AirPrint logo are trademarks of
Apple Inc.

• IOS is a trademark or registered trademark of Cisco in the U.S. and other countries and is used under
license.

• Google Cloud Print, Google Chrome, Chrome OS, Chromebook, Android, Google Play, Google Drive,
Google Apps and Picasa are either registered trademarks or trademarks of Google Inc.

• Adobe, Flash, Photoshop, Photoshop Elements, Lightroom, Adobe RGB and Adobe RGB (1998) are
either registered trademarks or trademarks of Adobe Systems Incorporated in the United States and/or
other countries.

• Bluetooth is a trademark of Bluetooth SIG, Inc., U.S.A. and licensed to Canon Inc.
• Autodesk and AutoCAD are registered trademarks or trademarks of Autodesk, Inc., and/or its

subsidiaries and/or affiliates in the USA and/or other countries.

Note
• The formal name of Windows Vista is Microsoft Windows Vista operating system.

Copyright (c) 2003-2004, Apple Computer, Inc. All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided
that the following conditions are met:

1. Redistributions of source code must retain the above copyright notice, this list of conditions and the
following disclaimer.

2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions and
the following disclaimer in the documentation and/or other materials provided with the distribution.

3. Neither the name of Apple Computer, Inc. ("Apple") nor the names of its contributors may be used to
endorse or promote products derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY APPLE AND ITS CONTRIBUTORS "AS IS" AND ANY EXPRESS
OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT
SHALL APPLE OR ITS CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL,
SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO,
PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR
BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER
IN CONTRACT, STRICT LIABILITY, OR TORT INCLUDING NEGLIGENCE OR OTHERWISE) ARISING
IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF
SUCH DAMAGE.
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Apache License

Version 2.0, January 2004

http://www.apache.org/licenses/
TERMS AND CONDITIONS FOR USE, REPRODUCTION, AND DISTRIBUTION

1. Definitions.

"License" shall mean the terms and conditions for use, reproduction, and distribution as defined by
Sections 1 through 9 of this document.

"Licensor" shall mean the copyright owner or entity authorized by the copyright owner that is granting
the License.

"Legal Entity" shall mean the union of the acting entity and all other entities that control, are controlled
by, or are under common control with that entity. For the purposes of this definition, "control" means
(i) the power, direct or indirect, to cause the direction or management of such entity, whether by
contract or otherwise, or (ii) ownership of fifty percent (50%) or more of the outstanding shares, or (iii)
beneficial ownership of such entity.

"You" (or "Your") shall mean an individual or Legal Entity exercising permissions granted by this
License.

"Source" form shall mean the preferred form for making modifications, including but not limited to
software source code, documentation source, and configuration files.

"Object" form shall mean any form resulting from mechanical transformation or translation of a Source
form, including but not limited to compiled object code, generated documentation, and conversions to
other media types.

"Work" shall mean the work of authorship, whether in Source or Object form, made available under
the License, as indicated by a copyright notice that is included in or attached to the work (an example
is provided in the Appendix below).

"Derivative Works" shall mean any work, whether in Source or Object form, that is based on (or
derived from) the Work and for which the editorial revisions, annotations, elaborations, or other
modifications represent, as a whole, an original work of authorship. For the purposes of this License,
Derivative Works shall not include works that remain separable from, or merely link (or bind by name)
to the interfaces of, the Work and Derivative Works thereof.

"Contribution" shall mean any work of authorship, including the original version of the Work and any
modifications or additions to that Work or Derivative Works thereof, that is intentionally submitted to
Licensor for inclusion in the Work by the copyright owner or by an individual or Legal Entity
authorized to submit on behalf of the copyright owner. For the purposes of this definition, "submitted"
means any form of electronic, verbal, or written communication sent to the Licensor or its
representatives, including but not limited to communication on electronic mailing lists, source code
control systems, and issue tracking systems that are managed by, or on behalf of, the Licensor for the
purpose of discussing and improving the Work, but excluding communication that is conspicuously
marked or otherwise designated in writing by the copyright owner as "Not a Contribution."

"Contributor" shall mean Licensor and any individual or Legal Entity on behalf of whom a Contribution
has been received by Licensor and subsequently incorporated within the Work.

2. Grant of Copyright License. Subject to the terms and conditions of this License, each Contributor
hereby grants to You a perpetual, worldwide, non-exclusive, no-charge, royalty-free, irrevocable
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copyright license to reproduce, prepare Derivative Works of, publicly display, publicly perform,
sublicense, and distribute the Work and such Derivative Works in Source or Object form.

3. Grant of Patent License. Subject to the terms and conditions of this License, each Contributor hereby
grants to You a perpetual, worldwide, non-exclusive, no-charge, royalty-free, irrevocable (except as
stated in this section) patent license to make, have made, use, offer to sell, sell, import, and otherwise
transfer the Work, where such license applies only to those patent claims licensable by such
Contributor that are necessarily infringed by their Contribution(s) alone or by combination of their
Contribution(s) with the Work to which such Contribution(s) was submitted. If You institute patent
litigation against any entity (including a cross-claim or counterclaim in a lawsuit) alleging that the
Work or a Contribution incorporated within the Work constitutes direct or contributory patent
infringement, then any patent licenses granted to You under this License for that Work shall terminate
as of the date such litigation is filed.

4. Redistribution. You may reproduce and distribute copies of the Work or Derivative Works thereof in
any medium, with or without modifications, and in Source or Object form, provided that You meet the
following conditions:

1. You must give any other recipients of the Work or Derivative Works a copy of this License; and
2. You must cause any modified files to carry prominent notices stating that You changed the files;

and
3. You must retain, in the Source form of any Derivative Works that You distribute, all copyright,

patent, trademark, and attribution notices from the Source form of the Work, excluding those
notices that do not pertain to any part of the Derivative Works; and

4. If the Work includes a "NOTICE" text file as part of its distribution, then any Derivative Works that
You distribute must include a readable copy of the attribution notices contained within such
NOTICE file, excluding those notices that do not pertain to any part of the Derivative Works, in at
least one of the following places: within a NOTICE text file distributed as part of the Derivative
Works; within the Source form or documentation, if provided along with the Derivative Works; or,
within a display generated by the Derivative Works, if and wherever such third-party notices
normally appear. The contents of the NOTICE file are for informational purposes only and do not
modify the License. You may add Your own attribution notices within Derivative Works that You
distribute, alongside or as an addendum to the NOTICE text from the Work, provided that such
additional attribution notices cannot be construed as modifying the License.

You may add Your own copyright statement to Your modifications and may provide additional or
different license terms and conditions for use, reproduction, or distribution of Your modifications,
or for any such Derivative Works as a whole, provided Your use, reproduction, and distribution of
the Work otherwise complies with the conditions stated in this License.

5. Submission of Contributions. Unless You explicitly state otherwise, any Contribution intentionally
submitted for inclusion in the Work by You to the Licensor shall be under the terms and conditions of
this License, without any additional terms or conditions. Notwithstanding the above, nothing herein
shall supersede or modify the terms of any separate license agreement you may have executed with
Licensor regarding such Contributions.

6. Trademarks. This License does not grant permission to use the trade names, trademarks, service
marks, or product names of the Licensor, except as required for reasonable and customary use in
describing the origin of the Work and reproducing the content of the NOTICE file.

7. Disclaimer of Warranty. Unless required by applicable law or agreed to in writing, Licensor provides
the Work (and each Contributor provides its Contributions) on an "AS IS" BASIS, WITHOUT
WARRANTIES OR CONDITIONS OF ANY KIND, either express or implied, including, without
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limitation, any warranties or conditions of TITLE, NON-INFRINGEMENT, MERCHANTABILITY, or
FITNESS FOR A PARTICULAR PURPOSE. You are solely responsible for determining the
appropriateness of using or redistributing the Work and assume any risks associated with Your
exercise of permissions under this License.

8. Limitation of Liability. In no event and under no legal theory, whether in tort (including negligence),
contract, or otherwise, unless required by applicable law (such as deliberate and grossly negligent
acts) or agreed to in writing, shall any Contributor be liable to You for damages, including any direct,
indirect, special, incidental, or consequential damages of any character arising as a result of this
License or out of the use or inability to use the Work (including but not limited to damages for loss of
goodwill, work stoppage, computer failure or malfunction, or any and all other commercial damages
or losses), even if such Contributor has been advised of the possibility of such damages.

9. Accepting Warranty or Additional Liability. While redistributing the Work or Derivative Works thereof,
You may choose to offer, and charge a fee for, acceptance of support, warranty, indemnity, or other
liability obligations and/or rights consistent with this License. However, in accepting such obligations,
You may act only on Your own behalf and on Your sole responsibility, not on behalf of any other
Contributor, and only if You agree to indemnify, defend, and hold each Contributor harmless for any
liability incurred by, or claims asserted against, such Contributor by reason of your accepting any
such warranty or additional liability.
END OF TERMS AND CONDITIONS

---- Part 1: CMU/UCD copyright notice: (BSD like) -----

Copyright 1989, 1991, 1992 by Carnegie Mellon University

Derivative Work - 1996, 1998-2000

Copyright 1996, 1998-2000 The Regents of the University of California

All Rights Reserved

Permission to use, copy, modify and distribute this software and its documentation for any purpose and
without fee is hereby granted, provided that the above copyright notice appears in all copies and that both
that copyright notice and this permission notice appear in supporting documentation, and that the name of
CMU and The Regents of the University of California not be used in advertising or publicity pertaining to
distribution of the software without specific written permission.

CMU AND THE REGENTS OF THE UNIVERSITY OF CALIFORNIA DISCLAIM ALL WARRANTIES
WITH REGARD TO THIS SOFTWARE, INCLUDING ALL IMPLIED WARRANTIES OF
MERCHANTABILITY AND FITNESS. IN NO EVENT SHALL CMU OR THE REGENTS OF THE
UNIVERSITY OF CALIFORNIA BE LIABLE FOR ANY SPECIAL, INDIRECT OR CONSEQUENTIAL
DAMAGES OR ANY DAMAGES WHATSOEVER RESULTING FROM THE LOSS OF USE, DATA OR
PROFITS, WHETHER IN AN ACTION OF CONTRACT, NEGLIGENCE OR OTHER TORTIOUS ACTION,
ARISING OUT OF OR IN CONNECTION WITH THE USE OR PERFORMANCE OF THIS SOFTWARE.

---- Part 2: Networks Associates Technology, Inc copyright notice (BSD) -----

Copyright (c) 2001-2003, Networks Associates Technology, Inc

All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided
that the following conditions are met:
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* Redistributions of source code must retain the above copyright notice, this list of conditions and the
following disclaimer.
* Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the
following disclaimer in the documentation and/or other materials provided with the distribution.
* Neither the name of the Networks Associates Technology, Inc nor the names of its contributors may be
used to endorse or promote products derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS ``AS IS''
AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED
WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE
DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT HOLDERS OR CONTRIBUTORS BE LIABLE
FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL
DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR
SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER
CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR
TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF
THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

---- Part 3: Cambridge Broadband Ltd. copyright notice (BSD) -----

Portions of this code are copyright (c) 2001-2003, Cambridge Broadband Ltd.

All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided
that the following conditions are met:

* Redistributions of source code must retain the above copyright notice, this list of conditions and the
following disclaimer.
* Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the
following disclaimer in the documentation and/or other materials provided with the distribution.
* The name of Cambridge Broadband Ltd. may not be used to endorse or promote products derived from
this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDER ``AS IS'' AND ANY EXPRESS OR
IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT
SHALL THE COPYRIGHT HOLDER BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL,
EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO,
PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR
BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER
IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING
IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF
SUCH DAMAGE.

---- Part 4: Sun Microsystems, Inc. copyright notice (BSD) -----

Copyright c 2003 Sun Microsystems, Inc., 4150 Network Circle, Santa Clara, California 95054, U.S.A. All
rights reserved.

Use is subject to license terms below.
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This distribution may include materials developed by third parties.

Sun, Sun Microsystems, the Sun logo and Solaris are trademarks or registered trademarks of Sun
Microsystems, Inc. in the U.S. and other countries.

Redistribution and use in source and binary forms, with or without modification, are permitted provided
that the following conditions are met:

* Redistributions of source code must retain the above copyright notice, this list of conditions and the
following disclaimer.
* Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the
following disclaimer in the documentation and/or other materials provided with the distribution.
* Neither the name of the Sun Microsystems, Inc. nor the names of its contributors may be used to
endorse or promote products derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS ``AS IS''
AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED
WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE
DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT HOLDERS OR CONTRIBUTORS BE LIABLE
FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL
DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR
SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER
CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR
TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF
THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

---- Part 5: Sparta, Inc copyright notice (BSD) -----

Copyright (c) 2003-2009, Sparta, Inc

All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided
that the following conditions are met:

* Redistributions of source code must retain the above copyright notice, this list of conditions and the
following disclaimer.
* Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the
following disclaimer in the documentation and/or other materials provided with the distribution.
* Neither the name of Sparta, Inc nor the names of its contributors may be used to endorse or promote
products derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS ``AS IS''
AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED
WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE
DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT HOLDERS OR CONTRIBUTORS BE LIABLE
FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL
DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR
SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER
CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR
TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF
THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.
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---- Part 6: Cisco/BUPTNIC copyright notice (BSD) -----

Copyright (c) 2004, Cisco, Inc and Information Network Center of Beijing University of Posts and
Telecommunications.

All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided
that the following conditions are met:

* Redistributions of source code must retain the above copyright notice, this list of conditions and the
following disclaimer.
* Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the
following disclaimer in the documentation and/or other materials provided with the distribution.
* Neither the name of Cisco, Inc, Beijing University of Posts and Telecommunications, nor the names of
their contributors may be used to endorse or promote products derived from this software without specific
prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS ``AS IS''
AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED
WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE
DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT HOLDERS OR CONTRIBUTORS BE LIABLE
FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL
DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR
SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER
CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR
TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF
THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

---- Part 7: Fabasoft R&D Software GmbH & Co KG copyright notice (BSD) -----

Copyright (c) Fabasoft R&D Software GmbH & Co KG, 2003 oss@fabasoft.com

Author: Bernhard Penz

Redistribution and use in source and binary forms, with or without modification, are permitted provided
that the following conditions are met:

* Redistributions of source code must retain the above copyright notice, this list of conditions and the
following disclaimer.
* Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the
following disclaimer in the documentation and/or other materials provided with the distribution.
* The name of Fabasoft R&D Software GmbH & Co KG or any of its subsidiaries, brand or product names
may not be used to endorse or promote products derived from this software without specific prior written
permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDER ``AS IS'' AND ANY EXPRESS OR
IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT
SHALL THE COPYRIGHT HOLDER BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL,
EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO,
PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR
BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER
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IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING
IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF
SUCH DAMAGE.

LEADTOOLS

Copyright (C) 1991-2009 LEAD Technologies, Inc.

CMap Resources

-----------------------------------------------------------

Copyright 1990-2009 Adobe Systems Incorporated.
All rights reserved.

Copyright 1990-2010 Adobe Systems Incorporated.
All rights reserved.

Redistribution and use in source and binary forms, with or
without modification, are permitted provided that the
following conditions are met:

Redistributions of source code must retain the above
copyright notice, this list of conditions and the following
disclaimer.

Redistributions in binary form must reproduce the above
copyright notice, this list of conditions and the following
disclaimer in the documentation and/or other materials
provided with the distribution.

Neither the name of Adobe Systems Incorporated nor the names
of its contributors may be used to endorse or promote
products derived from this software without specific prior
written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND
CONTRIBUTORS "AS IS" AND ANY EXPRESS OR IMPLIED WARRANTIES,
INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE
DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT HOLDER OR
CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL,
SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT
NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES;
LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION)
HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN
CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR
OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS
SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

-----------------------------------------------------------

MIT License
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Copyright (c) 1998, 1999, 2000 Thai Open Source Software Center Ltd

Permission is hereby granted, free of charge, to any person obtaining a copy of this software and
associated documentation files (the "Software"), to deal in the Software without restriction, including
without limitation the rights to use, copy, modify, merge, publish, distribute, sublicense, and/or sell copies
of the Software, and to permit persons to whom the Software is furnished to do so, subject to the following
conditions:

The above copyright notice and this permission notice shall be included in all copies or substantial
portions of the Software.

THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR
IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY, FITNESS
FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT. IN NO EVENT SHALL THE AUTHORS OR
COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER LIABILITY, WHETHER
IN AN ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING FROM, OUT OF OR IN
CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS IN THE SOFTWARE.

The following applies only to products supporting Wi-Fi.

(c) 2009-2013 by Jeff Mott. All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided
that the following conditions are met:

* Redistributions of source code must retain the above copyright notice, this list of conditions, and the
following disclaimer.
* Redistributions in binary form must reproduce the above copyright notice, this list of conditions, and the
following disclaimer in the documentation or other materials provided with the distribution.
* Neither the name CryptoJS nor the names of its contributors may be used to endorse or promote
products derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS,"
AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED
WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE, ARE
DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT HOLDER OR CONTRIBUTORS BE LIABLE
FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL
DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR
SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER
CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR
TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF
THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.
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Enter keywords in the search window and click  (Search).

You can search for target pages in this guide.

Entry example: "(your product's model name) load paper"

Search Tips

You can search for target pages by entering keywords in the search window.

Important
• This function may not be available in some countries/regions.

Note
• The displayed screen may vary.
• When searching from this page without entering your product's model name or your application's name,

all products supported by this guide will be considered for the search.
If you want to narrow down the search results, add your product's model name or your application's
name to the keywords.

• Searching for Functions

Enter your product's model name and a keyword for the function you want to learn about

Example: When you want to learn how to load paper
Enter "(your product's model name) load paper" in the search window and perform a search

• Troubleshooting Errors

Enter your product's model name and a support code

Example: When the following error screen appears
Enter "(your product's model name) 1003" in the search window and perform a search
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Note
• The displayed screen varies depending on your product.

• Searching for Application Functions

Enter your application's name and a keyword for the function you want to learn about

Example: When you want to learn how to print collages with My Image Garden
Enter "My Image Garden collage" in the search window and perform a search

• Searching for Reference Pages

Enter your model name and a reference page title*
* You can find reference pages more easily by entering the function name as well.

Example: When you want to browse the page referred to by the following sentence on a scanning
procedure page
Refer to "Color Settings Tab" for your model from Home of the Online Manual for details.
Enter "(your product's model name) scan Color Settings Tab" in the search window and perform a
search
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General Notes (Device Management Console)

When using Device Management Console, the following restrictions apply. Please familiarize yourself with
them before using it.

• See the Canon website for products that are compatible with Device Management Console.

• This guide primarily provides explanations using the screens that appear when you use OS X Yosemite
v10.10.

Connecting to a Printer
• Connecting to a Target Printer

We recommend using a network connection for printer connection.

• DHCP-connected Printer

We recommend that you set a static IP address on any managed printer.

Important
• When the power is turned off on a printer with a DHCP connection, the IP address may change

the next time the printer is turned on.

If the IP address changes, the printer must be registered again.

Printer Power
• The printer information cannot be acquired when the printer power is turned off automatically or it is

turned off with the power button.

In addition, information cannot be acquired from the software when the printer auto power off state or
the printer button off state is canceled.

Color Tone
• The color tone may not be stable even if color calibration is performed.

For details, see "Managing Colors" for your model from the Home of the Online Manual.
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The Features of Device Management Console

Use Device Management Console to check the status of a printer connected by a network or USB and to
perform color calibration for a selected printer.

In addition, you can check the recommended level of color calibration execution, execution logs, and
calibration link status.

Note
• In Device Management Console, multiple printers that can print with the same color are called

calibration-linked printers.

Checking Printer Status
Use the Printer Status sheet on the main screen to check the printer status.

Checking Printer Status

Checking Color Calibration Status
Use the Calibration sheet on the main screen to check the recommended level of color calibration
execution and execution logs.

Checking Color Calibration Execution Status

In addition, you can also check the calibration link status.

Checking Calibration Link

Performing Color Calibration
Use the Calibration sheet on the main screen to perform a color calibration for the selected printer.

Performing color calibration improves color consistency by compensating for slight differences in how
color appears due to individual variations or aging among printers.

Performing Color Calibration
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Starting Device Management Console

Follow the procedure below to start the Device Management Console.

1. Execute any of the following:

• Click the Device Management Console button on the Management Tool sheet in the Quick Utility
Toolbox.

• Select Applications from the Finder's Go menu, and then double-click in the following order:
Canon Utilities folder > Device Management Console folder > Canon Device Management
Console icon.

Note
• Quick Utility Toolbox is a Canon software application.

The Printer Status sheet on the main screen of Device Management Console appears.

Printers do not appear on the main screen at initial startup.

Register the managed printer while referring to "Registering Printer".
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Registering Printer

Register the printer for which you want to check the printer status or color calibration execution status.

Note
• The Calibration sheet does not appear for printers that do not support color calibration.

1. Click  button (or select Manage Printer from File menu).

Note
• This operation cannot be performed when acquiring information from the printer.

The Printer Management dialog box appears.

2. Click Add Printer button.
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Note
• For details on the Printer Management dialog box, see "Printer Management Dialog Box."

The Add Printer dialog box appears.

3. Select Auto (Network Connection) in Search Method, and click Search button.

Note
• For details on the Add Printer dialog box, see "Add Printer Dialog Box."

The printers found appear in Printer List.
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Note
• If the printer you want to register does not appear, check that the printer power is turned on and

check the network status, and then search again.

• When Search Method is set to USB, a search for local printers is performed.

4. From list of displayed printers, select check boxes of printers to register, and click Add
button.

The registered printers appear in the Printer Management dialog box.

5. Click the OK button.
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Note
• To change the displayed printer names, use the Advanced Printer Settings dialog box that

appears when you click the Advanced Settings button.

 

The registered printers appear on the main screen.

Note
• When switching the connection method of a registered printer between network and USB, first

delete the registered printer, and then register it again.
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Deleting Printer

Delete a managed printer.

The deleted printer is deleted from both the Printer Status and Calibration sheets.

1. Click  button (or select Manage Printer from File menu).

Note
• This operation cannot be performed when acquiring information from the printer.

The Printer Management dialog box appears.

2. Select printer to be deleted and click Unregister button.
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Note
• For details on the Printer Management dialog box, see "Printer Management Dialog Box."

The selected printer is deleted from the Printer List.

3. Click the OK button.

The managed printer is deleted.
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Checking Printer Status

Use the Printer Status sheet on the main screen to check the printer status.

Note
• To check the status of a printer, the managed printer must be registered in advance.

Registering Printer

1. Click Printer Status tab (or select Printer Status from View menu).

The Printer Status sheet appears.

2. Click  button (or select Update from View menu).
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The printer status that appears on the main screen is up to date.

Note

• Select a printer and click the  button to display the Printer Details dialog box, allowing you to
check the detailed printer information.

For details on the Printer Details dialog box, see "Printer Details Dialog Box."

• This operation cannot be performed when acquiring information from the printer.

3. To see more detailed information, select a printer, and click the Printer Information button.
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The Web browser starts, and the main screen of the Remote UI for the selected printer appears.

Important
• You cannot view detailed information about a printer with Remote UI for a printer connected with

USB or IPv6.
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Managing Printer Colors

Checking Color Calibration Execution Status

Checking Calibration Link

Performing Color Calibration
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Checking Color Calibration Execution Status

Use the Calibration sheet on the main screen to check the recommended level of color calibration
execution and execution logs.

Checking Advisability of Executing Color Calibration

Checking Color Calibration Execution Logs

Checking Advisability of Executing Color Calibration
You can check whether color calibration needs to be executed.

1. Click Calibration tab (or select Calibration from View menu).

2. From the printer list, select the printer for which you want to check the advisability of
executing color calibration.
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3. Select the media type in Media Type.

Note
• When Media Type cannot be selected, the paper loaded in the printer appears.

4. Check the progress bar of Calibration advisability.
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When the progress bar is yellow or red (progress bar is at 90% or more), we recommend that color
calibration be executed.

Important
• The progress bar display is used for reference for performing color calibration.

Perform color calibration when replacing the printhead or when you are concerned about
differences in color tone.

Checking Color Calibration Execution Logs
You can check the color calibration execution log for each paper.

1. Click Calibration tab (or select Calibration from View menu).
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2. From printer list, select printer for which you want to check color calibration execution log.

3. From paper list display criteria, select All.
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4. From paper list, select paper for which you want to check details and click Paper Status
button.

The Paper Status dialog box appears.
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You can check the color calibration status for the selected paper.

Note
• For details on the Paper Status dialog box, see "Paper Status Dialog Box."
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Checking Calibration Link

In Device Management Console, multiple printers that can print with the same color are called calibration-
linked printers.

Calibration-linked printers are grouped with the same calibration group name and displayed.

Important
• Calibration link is performed for multiple printers that meet the following conditions.

• The printer belongs to the same series that supports calibration link.

• The same media type is selected in Calibration sheet > Media Type on the main screen.

For models for which Media Type cannot be selected, the same media type is loaded in the printer.

• Color calibration is performed at least once for each printer with the above paper.

1. Click Calibration tab (or select Calibration from View menu).

The Calibration sheet appears.

2. To right of printer list, click  button (or select Update Calibration Link from View
menu).
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Calibration-linked printers are grouped with the same calibration group name and displayed.

Important

• For printers displayed with , you may not be able to print with the same color tone. See the

message displayed in the guide message area, and print after confirming that  is not
displayed.

For printers showing the message "The calibration target in the media information file is not
up-to-date.", use the Media Configuration Tool to export the media information of a printer not
showing this message, and then import the exported media information to the printer showing this
message. For information about exporting and importing media information, see "Media
Configuration Tool Guide" from the Home of the Online Manual.
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Note
• Move the mouse pointer over Calibration group to display the media type to be grouped.

• Double-click Calibration group to open and close the Calibration group tree.
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Performing Color Calibration

Use the Calibration sheet on the main screen to perform color calibration for the displayed printer.

Important
• You must load paper into the printer to perform color calibration.

For details on the paper that can be used for color calibration, see the following pages for your model
from the Home of the Online Manual.

• Model that supports roll paper

"Paper Information List"

• Model that does not support roll paper

"Paper that Can Be Used in Color Calibration"

1. Click Calibration tab (or select Calibration from View menu).

The Calibration sheet appears.

2. From printer list, select printer for which you want to perform color calibration.
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3. Click Calibration button (or select Calibration from Execute menu).

The Calibration dialog box appears.

4. Select the Media Type for color calibration.
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Note
• The media type for the paper fed on the printer appears depending on your model.

5. Verify the Status in the Confirmation Message.
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The Status in the Confirmation Message will let you know if color calibration is required.

Important
• If you are not performing color calibration, click the Cancel button.

6. Verify the Paper Source.

The paper sources for which color calibration can be performed are displayed for the paper in Media
Type.

If the displayed paper source and the paper loaded to perform color calibration are different, reload the
paper in the paper source displayed in Paper Source.

Note
• Depending on your model, you can select the Paper Source.

• If you are using a PRO-1000 or PRO-500 model, only the rear tray can be used as the paper
source for color calibration.

7. Click the OK button.

The color calibration starts and the Calibration Monitor dialog box appears.
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Important

• To update the color calibration progress status, you must click the  button.

• After 30 minutes have elapsed from the start of the color calibration and you close the dialog box,
you cannot check the progress status of the color calibration even if you display the Calibration
Monitor dialog box the next time.

• Depending your model, you cannot check the progress status of color calibration for a printer
connected by USB by closing this dialog box, and then displaying the Calibration Monitor dialog
box.

Note
• If you want to stop the color calibration, select the printer and then click the Cancel Calibration

button.

• To close this dialog box, click the  button.

Color calibration cannot be canceled by closing this dialog box.

• You can also display this dialog box by clicking the Calibration Monitor button on the Calibration
sheet.
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Description of Device Management Console Screen

Main Screen

Printer Management Dialog Box

Add Printer Dialog Box

Printer Details Dialog Box

Paper Status Dialog Box

Calibration Dialog Box

Calibration Monitor Dialog Box
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Main Screen

The main screen of Device Management Console consists of a menu bar, toolbar, main area, and status bar.

(1) Menu Bar

(2) Toolbar

(3) Main Area

(4) Status Bar

(1) Menu Bar
Select the menu items for the necessary operations.

Main Screen (Menu Bar)

(2) Toolbar
Displays the buttons of functions frequently used in Device Management Console.

Use the View menu in the menu bar to show/hide the toolbar.

 button
The Printer Management dialog box appears, allowing you to manage managed printers.
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 button
The Printer Details dialog box appears, allowing you to check the detailed information for the
selected printer.

(3) Main Area
The main area includes the Printer Status sheet and Calibration sheet.

Click Printer Status tab to display Printer Status sheet, and click Calibration tab to display Calibration
sheet. You can also use the View menu in the menu bar to select the display.

Main Screen (Printer Status Sheet)

Main Screen (Calibration Sheet)

(4) Status Bar
The Device Management Console settings status and printer communication status appear.

Use the View menu in the menu bar to show/hide the status bar.
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Main Screen (Menu Bar)

The menu bar on the main screen has the following menus.

Canon Device Management Console Menu

File Menu

View Menu

Execute Menu

Help Menu

Canon Device Management Console Menu

About Canon Device Management Console
You can check the Device Management Console version.

Quit Canon Device Management Console
Exits Device Management Console.

File Menu

Printer Details
The Printer Details dialog box appears, allowing you to check the detailed information for the
selected printer.

Manage Printer
The Printer Management dialog box appears, allowing you to manage managed printers.
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View Menu

Toolbars
Shows/hides the toolbar on the main screen.

When the check box is selected, the toolbar appears.

Status Bar
Shows/hides the status bar on the main screen.

When the check box is selected, the status bar appears.

Update
The printer status that appears on the Printer Status sheet is up to date.

Update Calibration Link
Updates the printer list on the Calibration sheet.

Printer Status/Calibration
Select Printer Status to display the Printer Status sheet.

Select Calibration to display the Calibration sheet.

Paper List
Selects the media types displayed in the paper list on the Calibration sheet.

Calibrated
Only color-calibrated paper appears.

All
All paper appears.

Custom Paper
Only custom paper appears.

Custom paper is paper added with Media Configuration Tool.

To execute color calibration with custom paper, the calibration target for that paper must be
created.

For details on custom paper and creating a calibration target, refer to "Media Configuration Tool
Guide" from the Home of the Online Manual.
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Paper Status
The Paper Status dialog box appears, allowing you to check the color calibration status of the
selected paper.

Update Paper List
Updates the paper list on the Calibration sheet.

Execute Menu

Printer Information
The Web browser starts, and the main screen of the Remote UI for the selected printer appears.

Calibration
The Calibration dialog box appears, allowing you to perform color calibration for the selected paper.

Calibration Monitor
The Calibration Monitor dialog box appears, allowing you to check the color calibration progress
status.

Help Menu

Instructions
The Online Manual appears.
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Main Screen (Printer Status Sheet)

Use the Printer Status sheet to monitor the status of managed printers.

Note
• If the printer you want to manage is not displayed, use the Printer Management dialog box to register

the printer.

Registering Printer

(1) Printer Status Update Area

(2) Printer Status Display Area

(3) Message Area

(4) Advanced Printer Information Area

(1) Printer Status Update Area

 button
Updates the printer status.

(2) Printer Status Display Area
The status for each printer appears.

Note
• Click the heading to sort by clicked item.
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Warning / Error Icons
The icons below appear to the left of Printer Name when a printer warning or error occurs.

Note
• For details on the warnings and errors, either click the Printer Information button to display

Remote UI, or refer to "Troubleshooting" for your printer model from the Home of the Online
Manual.

A warning has occurred.

An operator error has occurred.

Information about the remaining amount of ink, etc.

An error requiring repair has occurred.

Printer Name
The name of the printer appears.

Connection
Displays the IP address of printers connected via the network and the connection port name of
printers connected via USB.

Warning/Error Count
The number of warnings and errors occurring appear.

Status
The simplified status of the printer appears. If there are multiple warnings and errors, the highest
priority one appears.

(3) Message Area
Messages for the status of all managed printers appear.

(4) Advanced Printer Information Area
Printer Information button

The Web browser starts, and the main screen of Remote UI for the selected printer appears, allowing
you to check the printer information details.
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Important
• You cannot view detailed information about a printer with Remote UI for a printer connected with

USB or IPv6.
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Main Screen (Calibration Sheet)

Use the Calibration sheet to execute color calibration for the managed printer and to check the color
calibration status.

Note
• If the printer you want to manage is not displayed, use the Printer Management dialog box to register

the printer.

Registering Printer

(1) Printer List Area

(2) Execute Color Calibration Area

(3) Color Calibration Execution Log Area

(4) Color Calibration Progress Status Area

(1) Printer List Area
The managed printers are organized and displayed by color calibration status.

Click the  button to update the printer list.

Note

• A warning related to color calibration has occurred on printers with  displayed.

The error details appear in the guide message area of "(2) Execute Color Calibration Area".

In Device Management Console, multiple printers that can print with the same color are called calibration-
linked printers.
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Calibration-linked printers are grouped with the same calibration group name and displayed.

Important
• Calibration link is performed for multiple printers that meet the following conditions.

• The printer belongs to the same series that supports calibration link.

• The same media type is selected in Calibration sheet > Media Type on the main screen.

For models for which Media Type cannot be selected, the same media type is loaded in the
printer.

• Color calibration is performed at least once for each printer with the above paper.

Note
• Move the mouse pointer over Calibration group to display the media type to be grouped.

• Double-click Calibration group to open and close the Calibration group tree.

(2) Execute Color Calibration Area

Media Type
Select a media type supported by the printer.

Important
• Depending on the model used, displays only the media type loaded in the printer-.

(2-1) Guide message area
Messages related to color calibration appear.

Calibration button
The Calibration dialog box appears, allowing you to perform color calibration.

Calibration advisability
Displays the advisability for executing color calibration. The progress bar grows until the time when
calibration is recommended.
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(3) Color Calibration Execution Log Area
The color calibration execution log for each paper appears.

(3-1) Paper list display conditions
From the drop-down list, select the criteria for displaying items in the paper list.

Calibrated
Only color-calibrated paper appears.

All
All paper appears.

Custom Paper
Only custom paper appears.

Custom paper is paper added with Media Configuration Tool.

To execute color calibration with custom paper, the calibration target for that paper must be
created.

For details on custom paper and creating a calibration target, refer to "Media Configuration Tool
Guide" from the Home of the Online Manual.

 button
Updates the paper list.

(3-2) Paper list
The color calibration execution log for each paper appears.

Note
• Click the heading to sort by clicked item.

•  appears for paper displayed in Media Type of "(2) Execute Color Calibration Area".

Media Type
The paper name acquired from the printer appears.

Status
The status and guide messages related to color calibration appears.
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Note
• If you delete or hide the paper used for the color calibration in Media Configuration Tool, that

paper will be displayed as Unknown Paper in Status column.

In such cases, use different paper and carry out the color calibration.

Date and Time of Last Calibration
The date color calibration was last performed appears.

Paper Status button
The Paper Status dialog box appears, allowing you to check the color calibration status of the
selected paper.

(4) Color Calibration Progress Status Area
Calibration Monitor button

The Calibration Monitor dialog box appears, allowing you to check the color calibration progress
status.

Important
• You cannot check the progress status for the following color calibration.

• Color calibration performed from the operation panel of a printer

• Color calibration of a printer connected by USB (for model that does not support roll paper)
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Printer Management Dialog Box

You can register and delete managed printers .

You an also change a printer's display name, and export and import information for managed printers.

Click  button or select Manage Printer from File menu to display Printer Management dialog box.

Printer List
Displays the list of managed printers.

Number of Managed Printers
Displays the total number of printers that appear in Printer List.

Printer Name
The printer name appears.

Connection
Displays the IP address of printers connected via the network and the connection port name of
printers connected via USB.

MAC Address
The MAC address of the printer appears.

Note
• For printers that support wired and wireless LAN, the MAC address that appears here is the

wired LAN MAC address.

Status
The printer support status appears.

Add Printer button
The Add Printer dialog box appears, allowing you to register a managed printer.
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Unregister button
The printer selected in Printer List is deleted.

Note
• You cannot click this button if a printer is not selected.

Advanced Settings button
The Advanced Printer Settings dialog box appears, allowing you to change the printer display name.

Note
• You cannot click this button if a printer is not selected.

Import button
Imports the managed printer(s) from a file.

The managed printers that are imported in Printer List appears.

Important
• When importing a printer connected with IPv6, you must turn on the printer and establish

communications.

If you import while communications are not established, Not Found appears under Status in the
Printer List, and the printer cannot be registered. If this happens, temporarily delete the printer
from the Printer List with the Unregister button, turn on the printer, and import again after the
communications have been established.

Export button
Exports the managed printers displayed in Printer List to a file.

Note
• A printer connected by USB cannot be exported.
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Add Printer Dialog Box

You can search for a printer to be managed and register it to the list of managed printers.

Click Add Printer button on Printer Management dialog box to display Add Printer dialog box.

Search Method
Select the printer search method.

Auto (Network Connection)
Searches for IPv4 and IPv6 printers.

IPv4
Searches by specifying the IPv4 IP address in IP Address.

IPv6
Searches by specifying the IPv6 IP address in IP Address.

USB
Searches for printers connected via USB.

IP Address
When IPv4 or IPv6 is selected in Search Method, enter the IP address of the printer for which to
search.

Search button
Starts printer search using the selected search method.

Printer List
The printer search result appears.

Printer Name
The model names of the printers found appears.

To register a printer, select the check box next to the model name.
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Connection
Displays the IP address of printers connected via the network and the connection port name of
printers connected via USB.

Stop Searching button
Click to stop the search.

Add button
When the check box is selected, the printer is registered to the managed printers, and the Add Printer
dialog box closes.
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Printer Details Dialog Box

The printer details of the selected printer appears.

Click  button or select Printer Details from File menu to display Printer Details dialog box.

Printer Name
Displays the name of the printer that appears in Device Management Console.

Product Name
The product name of the printer appears.

Connection
Displays the IP address of printers connected via the network and the connection port name of printers
connected via USB.

Installation Location
The installation location of the printer appears.

Note
• Nothing appears if no information can be acquired from the printer.

• Depending on the model used, nothing may appear.

Firmware Version
The version of the firmware installed on the printer appears.

Note
• Nothing appears if no information can be acquired from the printer.
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Serial Number
The serial number of the printer appears.

Status
The simplified status of the printer appears.

61



Paper Status Dialog Box

The color calibration status for the paper selected in the paper list appears.

Click Paper Status button on Calibration sheet or select Paper Status from View menu to display Paper
Status dialog box.

Media Type
The name of the paper selected in the paper list appears.

Calibration
The information of the color calibration applied to the selected paper appears.

The information of the selected paper only when color calibration has been executed for the selected
paper appear.

Paper
The paper name only when color calibration is executed appear.

Date
The date color calibration was executed appear.

Calibration advisability
Displays the advisability for executing color calibration. The progress bar grows until the time when
calibration is recommended.
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Calibration Dialog Box

You can check the color calibration status and perform color calibration.

Click Calibration button on Calibration sheet or select Calibration from Execute menu to display
Calibration dialog box.

Media Type
Select a media type supported by the printer.

Note
• The media type for the paper fed on the printer appears depending on your model.

Paper Source
Displays the paper source that can be used to perform color calibration with the media that appears in
Media Type.

Note
• Depending on your model, you can select the Paper Source.

• If you are using a PRO-1000 or PRO-500 model, only the rear tray can be used as the paper
source for color calibration.

Confirmation Message
Messages related to color calibration appear.
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Calibration Monitor button
The Calibration Monitor dialog box appears, allowing you to check the color calibration progress
status.

OK button
The color calibration starts and the Calibration Monitor dialog box appears.
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Calibration Monitor Dialog Box

You can check the progress status of the color calibration.

Click Calibration Monitor button on Calibration sheet, Calibration Monitor or OK button on Calibration
dialog box, or select Calibration Monitor on Execute menu to display Calibration Monitor dialog box.

Important
• You cannot check the progress status for the following color calibration.

• Color calibration performed from the operation panel of a printer

• Color calibration of a printer connected via USB (except when displayed with the OK button on the
Calibration dialog box on a model that does not support roll paper)

 button
The progress status of color calibration will be updated.

Printer Name
The printer name appears.

Media Type
The media type appears.

Date
The date when color calibration was started appears.

Status
The progress status of color calibration appears.

Cancel Calibration button
Stops color calibration on the selected printer.

Note
• To close this dialog box, click the  button or select Quit Canon Calibration Tool from the Canon

Calibration Tool menu.

Color calibration cannot be canceled by closing this dialog box.
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